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When to Submit Your Rosters to DECAL 

E-mail Notification 

Bright from the Start: Georgia Department of Early Care and Learning (DECAL) will send an e-mail 
notification when rosters are open for entry. The e-mail will provide the Roster Count Date and the Roster 
Due Date. You can begin Roster Entry at this time, but you cannot submit the roster until the Count Date. 
 
Updates to the Teacher Data may be done at any time. Student Data can only be added/updated when the 
Roster is open for student data entry. For questions regarding Teacher data entry, refer to the PANDA 
Teacher Data Training Document found on the PANDA Resources page located at www.decal.ga.gov 
under the Providers tab. 
 

PANDA Critical Reporting Dates  

There are several ways to view the roster count dates. 

1. The roster count dates are included in the PANDA Critical Reporting Dates document that you read 
and acknowledged as part of the application process. You may open and print your application 
documents at any time during the school year. To view the Panda Critical Dates document, complete 
the following steps: 

a. In the left-side navigation menu, select Pre-K. 

b. Click Enter Application. 

 
 
 
 

 
 
 
 
 

 
 

The application opens on the Read Me Files tab. 

c. Click the PANDA Critical Reporting Dates link in the Pre-K Application Mandatory 
Documents section.   

 

2021 Pre-K 10 Month Program 

http://www.decal.ga.gov/
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d. The document opens in a separate window. When you are finished with the document, close 

the window. 
 

2. The Calendar is preloaded with important Pre-K information, such as the roster count dates. 

a. In the lower right corner on the Panda home page, hover your mouse over a highlighted day to 
display the details for that date.  

 

b. To check future or past dates, click the left arrow (>) to scroll forward a month and the right 
arrow (<) to scroll back a month.  

 

 
 
 

November 2020 



 Student Data Training Document 

Bright from the Start : Georgia Department of Early Care and Learning Page 5 of 44 

What to Submit on Your Rosters to DECAL 

Your roster should include the following: 

 New students that have met all Georgia Pre-K enrollment requirements and have physically 
attended for at least 1 day. There is no need to list a student who was a no-show. 

 All students enrolled in your program on the count date even if the student is absent on the count 
date. 

 Students who un-enrolled from your program since the previous roster count date. These students 
should now have end dates. 

 
 
 

The number of students enrolled in a class on any date may not exceed the number of students approved 
in your contract unless DECAL has granted a class size waiver. If your roster includes both un-enrolled 
students and new students, their enrollment dates cannot overlap as this will cause the total number of 
students enrolled on any given date during the roster cycle to exceed the number of approved students.  

 
 

How to Enter Your Student Information 

There are two ways to enter your students onto Roster 1: 

Method 1: You can manually enter each student online via the Add Student screen. These instructions 
begin on page 6.    
 

Method 2: You can upload your students in bulk via an Excel template. These instructions begin on page 
12. This method can be used by both private and public providers.  

 

All public schools who are using Infinite Campus, Pearson PowerSchool, or 
Aspen should use this method to enter students onto Roster 1. 

 

 
 

If you failed to include a student on a roster previously submitted to DECAL, you can add the 
student onto the next roster; however, you cannot back date the entry to correct the mistake.  The 
Begin Date you enter has to be greater than the Count Date of the prior roster.  It is highly recommended 
that you carefully review each roster for accuracy before submitting. 

 

Important 
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Entering Students via the Online Process 

1. Launch PANDA and log in with your credentials.  

 For information about PANDA user accounts, refer to the PANDA Provider User 
Management document found on the PANDA Resources page located at www.decal.ga.gov 
under the Providers tab.  

 
2. In the left-side navigation menu, select (a) Pre-K, click on (b) Rosters, and then click on 

(c)View/Edit Roster.  

  
 
The Roster Provider Site List page opens. The Site Name column displays each Site Name as a 
hyperlink. 

 
3. To choose a site, click the Site Name.  

 
 

http://www.decal.ga.gov/panda
http://www.decal.ga.gov/documents/attachments/ProviderUserMgmt.pdf
http://www.decal.ga.gov/documents/attachments/ProviderUserMgmt.pdf
http://www.decal.ga.gov/
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The Roster Class List displays. The Class ID column displays each Class ID as a hyperlink. 
 

4. To choose a class, click on the desired Class ID.  

 
 

5. On the roster details screen, scroll down to the Student Information section and click the Add button.  

 
 

6. The Student Information screen displays as shown below. 
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7. Complete the following fields for each student who has physically been in attendance for at least 1 day: 

Field Action Required 

 Student Last 

Name  

Enter the student’s Last Name exactly as it appears on their birth certificate.  The 

student’s last name must have two or more letters and may include hyphens, 
apostrophes, and periods. Do not include a suffix as part of the last name (e.g., 
D’Angelo, Smith-Kline, or St. Claire).  

 Student First 

Name  

Enter the student’s First Name exactly as it appears on their birth certificate.  The 

student’s first name must have at least two letters. The first name can include two 
names separated by hyphens, apostrophes, spaces, or periods (e.g., Jean-Paul, 

Da’Shandra, or T.J.). 

 Student Middle 
Name  

Enter the student’s full middle name exactly as it appears on their birth certificate. 
Hyphens, apostrophes, and periods may be included.  If the student does not have 
a Middle Name, enter NMN to represent No Middle Name. This indicates you 
have verified there is not a middle name listed on the student’s birth certificate.  

 Suffix If applicable, select either Jr, II, III, IV, etc. from the drop-down. 

 Date of Birth  Enter the student's birthday exactly as it appears on their birth certificate using the 
format “MM/DD/YYYY”. 

 SSN  Enter the student's SSN (Social Security Number). It will be encrypted in the 
system to ensure data security.  

 Please verify that each student’s SSN was entered correctly. 

 If the SSN is omitted, a waiver signed by the parent/guardian is required 

to be on file at the site and will need to be provided to DECAL upon 
request if needed. 

 
Note (1):  If the SSN is omitted and you click Save, PANDA displays an error message. You will need to enter 
the information from the SSN Waiver form into the SSN Waiver Reason section by following steps (a) and (b).  

 

(a) Select the appropriate checkbox next to the Waiver Reason 
specified by the Parent on the Social Security Number Information 

Form (Appendix B in the Pre-K Operating Guidelines). 

(b) If the parent selected ‘I do not choose to 

provide the SSN because …’, enter the 
reason in the Waiver Reason Detail field 
exactly as the parent entered it on the 
Waiver Form. 
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Note (2):  To add a SSN after the student information has been saved, return to the Roster Detail screen 
and click on the POPULATE SSN link next to the desired student’s name. Then enter the SSN and click 
Save. You do not need to close/re-add the student in order to populate the SSN. 
 

 

CORRECTING NAME/DOB/SSN AFTER STUDENT HAS BEEN SAVED 
If you realize after entering a student that a correction is needed to one of these key fields (e.g., Last 
Name, First Name, Middle Name, Date of Birth, or SSN), DO NOT close and re-enter the student. 
Instead, send a copy of the age documentation (for changes needed to the Name/Date of Birth) or SSN 
card (for changes needed to the SSN) to Panda Rosters via the secured fax line at 404-651-8576. Closing 
and re-entering the student will flag the student as a duplicate and will require submission of student 
documentation to DECAL. 

 

Field Action Required 

 Gender  Select the student’s gender from the drop-down:   

 Male  Female 
 

 Multiple Birth  From the Multiple Birth drop-down list, select whether the student is from a single 
birth, twins, or a higher-order multiples (triplets or more) birth.  

Select Description For example, if 

John and Sally 

are twins, both 
would have “2” 
selected for 

Multiple Birth. 

1 If the child was born from a single birth 

2 If the child was born from a twin birth 

3 If the child was born from a triplet birth 

4 If the child was born from a quadruplet birth 

5 If the child was born from a quintuplet birth 
0 

 Transportation  Select the student’s Transportation indicator from the drop-down list. If the Center 
transports the child to and from Pre-K, select Yes.   

 Yes  No 
 

 Socio/Economic  Select the appropriate Socio-Economic indicator from the drop-down.  

 Category 1      Select this option if the child and/or child’s family participates in one 
of the following: Supplemental Nutrition Assistance program (SNAP), SSI 
(Supplemental Security Income), Medicaid, Temporary Assistance to Needy Families 
(TANF), or Child and Parent Services (CAPS) program. Documentation of 
participation must be verified and kept on file. Children who participate in the free 
and reduced meal program through the school that they attend may also be eligible as 
Category One if income eligibility is verified and kept on file.  

 Category 2      Select this option if the child does not meet the requirements for 
Category 1 eligibility. 

 

 

CORRECTING TRANSPORTATION & CATEGORY 
If you need to edit these fields prior to submission of Roster 1, you can click on the student’s name and 
enter the corrected values. If you need to edit these fields after Roster 1 has been submitted, you can now 
easily edit them on subsequent rosters by clicking on the Chg Trans/Socio button. Simply enter the 
corrected values and the system will prompt you for an effective date button for each field you change. 
You no longer need to close the student and re-add the student as was required in the past. 

 
 

Important 

Important 
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Field Action Required 

 DLL Select the appropriate option for the DLL (Dual Language Learner) indicator from 

the drop-down list: 

Select Description 

Yes If the student speaks multiple languages 

No If the student speaks only one language 

o 

 IEP Select the appropriate option for the IEP (Individual Education Plan) from the 

drop-down list: 

Select Description 

Yes If an IEP is in place for the student 

No If the student does not have an IEP 

o 

 Funding  Select the Class Funding Source from the drop-down list: 

Select Description 

Blended If the class receives both Head Start and Pre-K funding 

Lottery If the class only receives Pre-K funding 

o 

 Ethnicity  Select the student's ethnicity from the drop-down list:  

 Hispanic/Latino  Not Hispanic/Latino  Information not provided 
 

 Race  From the Race choices displayed, select all values that apply to this student:   

 American Indian/Alaskan Native 

 Asian 

 Black or African American 

 Native Hawaiian/Other Pacific Islander 

 White 

 Information not provided 
o 

 
 

 

The Gender, Multiple Birth, and IEP fields are links that you can click on to easily change to the 
correct value since they do not impact your payment.  

To change Gender, Multiple Birth, or IEP, click on the hyperlinked value. The field menu opens. 

 

Select the correct value and click  to save the change.  

 

Important 



 Student Data Training Document 

Bright from the Start : Georgia Department of Early Care and Learning Page 11 of 44 

 

Field Action Required 

 Parent/Guardian 

Last Name 

Enter the last name of the student’s Parent or Guardian (mother preferred if 

available). 

 Parent/Guardian 

First Name 

Enter the first name of the student’s Parent or Guardian (mother preferred if 

available). 

 Relationship From the drop-down list, select the appropriate relationship of the Parent or 

Guardian to the student:  

 Mother  Father   Grandparent  Guardian 
o 

 

 

 

Entering the Parent or Guardian information is optional; however, completion of all three fields 
becomes mandatory if data is populated in one of the fields. For example, if the Parent/Guardians 
first name is entered, then their last name and the relationship to the student must also be provided. 

 
 

Field Action Required 

 Begin Date in 
Class  

Enter the student’s first day in the Pre-K class using the format 
“MM/DD/YYYY”. 

 The Begin Date cannot be on or prior to the Count Date of the previous 
Roster.  

 For Roster 1, the Begin Date cannot be prior to August 1st. 

 The Begin Date cannot be after the Count Date of the current roster. 

 End Date in Class  If applicable, enter the student's last day in the Pre-K class using the format 

“MM/DD/YYYY”.   

 This date should only be entered if the student has un-enrolled from the 

class.   

 The End Date cannot be after the count date of the current roster. 

 The End Date cannot be a future date. 

 

8. Click .   
 

9. Click the  button to return to the Roster Class List or click  to enter another student onto the 
roster. 

 
 

If you entered students via the online process, proceed to Submitting Your Completed Roster to Decal 
(page 34) for instructions on how to submit your roster. 

 
 

 

Important 



 Student Data Training Document 

Bright from the Start : Georgia Department of Early Care and Learning Page 12 of 44 

Entering Students via the Upload Process 

Typically, the upload process is used by Providers with multiple sites/classes, but it can also be a time-
saver for those who have only one site/class. Using the upload process is a key advantage because the files 
can be created outside of PANDA prior to the date Roster Cycle 1 opens for entry. DECAL recommends 
that (1) a separate file be created for each site within your program and (2) the separate file should include 
all students for all classes at that site. If you have a large number of classes at one site, please consider 
creating a separate file for each class.  
 
The upload process is only applicable to the first roster cycle of the school year. To enter additional 
students after the upload, add them manually using the online process described earlier in this document.     
 
 
 

All Public schools using Infinite Campus, PowerSchool, or ASPEN are expected to obtain and upload 
the pre-populated files available to them. DO NOT manually type the student data into the Decal 
template. 

 
 
The upload process consists of two steps: 

1. Create student upload file(s) for each Site by using one of the following templates: 

 the DECAL template from the agency’s website 
(http://www.decal.ga.gov/documents/attachments/Student_Roster_Template.xls)  

 the pre-populated template from Infinite Campus  

 the pre-populated template from PowerSchool    

 the pre-populated template from ASPEN 
 
2. Upload the completed student roster file(s) and resolve any errors. 
 
 
Separate instructions are given below based on whether you are manually populating the DECAL template 
or whether you are using a pre-populated template from your data vendor. The instructions are different for 
each method, so be sure to follow the section below that is appropriate for your specific program.     

 If using the DECAL template, please proceed to page 13. 

 If your school system uses Infinite Campus, please proceed to page 19. 

 If your school system uses PowerSchool, please proceed to page 22. 

 If your school system uses ASPEN, please proceed to page 26. 

 
The pre-populated templates are currently only applicable to public schools who use Infinite Campus, 
PowerSchool, or ASPEN as their data vendor.   
 
 

Important 

http://www.decal.ga.gov/documents/attachments/Student_Roster_Template.xls


 Student Data Training Document 

Bright from the Start : Georgia Department of Early Care and Learning Page 13 of 44 

Creating an Upload File Using the DECAL Template 

1. On the Panda home page, scroll down to the Panda Resources section and click on Click here. 
 

2. Select the PANDA Student Roster Template option from the Document List.  

(a) Save the .xls file to a folder on your computer.   

(b) You will need to download the current template at the beginning of each school year. 
 

3. Double-click on the .xls file you just saved, which will launch Microsoft Excel.  
 

4. Follow the instructions shown in the header rows highlighted in red and begin entering your data on 
line 8 of the excel worksheet. 

 

 

If you are populate the template in advance of the school year with students chosen in the lottery, 
remember you must remove any students who were no-shows prior to uploading your file to 
PANDA. When uploaded, the file should only include students who were physically in attendance 
for 1 day or more.  

 

 
 

As you tab through each column, a popup will be displayed clarifying what each column represents.     
Where applicable, a dropdown has been added for a column if there is a restricted list of valid values 
allowed. You will need to verify your Site ID and Class ID values each year, as the Class ID 
values change each school year. 
 

The columns included in the template are listed below:   

Column – Field Action Required 

A – Site ID Enter the Site ID for the class you are uploading. 

(a) To verify your Site ID, go to Panda and click on Pre-K, Rosters, and then 

View/Edit Roster. 

(b) On the Provider Site List page displayed, scroll to your County/Site Name 
to locate the Site ID.  

 

Important 
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Column – Field Action Required 

B – Class # Enter the Class ID.  

(a) To determine your Class ID, click on your Site Name. 

(b) The Class List page displays the Class IDs for each class at that Site. 

 

C – Student Last 

name 

Enter the student’s Last Name exactly as it appears on their birth certificate.  The 

student’s last name must have two or more letters and may include hyphens, 
apostrophes, and periods.  Do not include a suffix as part of the last name (e.g., 
D’Angelo, Smith-Kline, or St. Claire).  

D – Student First 
name 

Enter the student’s First Name exactly as it appears on their birth certificate.  The 
student’s first name must have at least two letters.  The first name can include two 

names separated by hyphens, apostrophes, spaces, or periods (e.g., Jean-Paul, 
Da’Shandra, or T.J.). 

E – Student SSN Enter the student’s SSN (Social Security Number) using the format “123456789” 
without dashes. It will be encrypted in the system to ensure data security.  

 If the SSN has a leading zero, you will need to precede the value 
entered with an apostrophe (i.e., ‘012345678). Otherwise, Excel will 
drop the leading zero(es) and the record will be flagged as an error in 

the upload for being less than 9 digits. 

 Please verify that each student’s SSN was entered correctly. 

 If the SSN is omitted, a waiver signed by the parent/guardian is required to 
be on file at the site and will need to be provided to DECAL upon request if 
needed. 

 
Note:  If you are a public school district and have already assigned a ‘999’ pseudo-

social, leave this field blank and be sure to populate the waiver information into 
Columns S and T. 

F – Student Gender Select the student’s gender from the dropdown:   

 M = Male  F = Female 
 

G – Student DOB Enter the student’s Date of Birth exactly as it appears on their birth certificate using 

the format “MM/DD/YYYY”. 
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Column – Field Action Required 

H – Birth Indicator From the Multiple Birth drop-down list, select whether the student is from a single 
birth, twins, or a higher-order multiples (triplets or more) birth.  

Select Description 

1 If the child was born from a single birth 

2 If the child was born from a twin birth 

3 If the child was born from a triplet birth 

4 If the child was born from a quadruplet birth 

5 If the child was born from a quintuplet birth 

O 

For example, if John and Sally are twins, both would have “2” selected for Multiple 

Birth. 

I – Socio/Economic Select the appropriate Socio-Economic indicator from the drop-down.  

 Category 1      Select this option if the child and/or child’s family participates in one of  
the following: Supplemental Nutrition Assistance program (SNAP), SSI (Supplemental 
Security Income), Medicaid, Temporary Assistance to Needy Families (TANF), or 
Child and Parent Services (CAPS) program. Documentation of participation must be 
verified and kept on file. Children who participate in the free and reduced meal program 
through the school that they attend may also be eligible as Category One if income 
eligibility is verified and kept on file.  
 

 Category 2      Select this option if the child does not meet the requirements for 
Category 1 eligibility. 

J – Transportation  Select the student’s Transportation indicator from the drop-down list. If the Center 
transports the child to and from Pre-K, select Yes.   

 Yes  No 
 

K – Ethnicity  Select the student's ethnicity from the drop-down:  

 Hispanic/Latino  Not Hispanic/Latino 
 

L – Dual Language 
Learner 
Indicator 

Select the appropriate option from the DLL (Dual Language Learner) indicator from 
the drop-down list: 

Select Description 

Yes If the student speaks multiple languages 

No If the student speaks only one language 

o 

M – IEP  Select the appropriate option for the IEP (Individual Education Plan) from the drop-

down list: 

Select Description 

Yes If an IEP is in place for the student 

No If the student does not have an IEP 

o 

N – Funding  Select the Class Funding Source from the drop-down list: 

Select Description 

Blended If the class receives both Head Start and Pre-K funding 

Lottery If the class only receives Pre-K funding 

o 

O – Begin Date Enter the student’s first day in the Pre-K class using the format “MM/DD/YYYY”. 

 The Begin Date cannot be on or prior to the Count Date of the previous 
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Column – Field Action Required 
Roster.   

 For Roster 1, the Begin Date cannot be prior to August 1st. 

 The Begin Date cannot be after the Count Date of the current roster. 

P – End Date If applicable, enter the student's last day in the Pre-K class using the format 

“MM/DD/YYYY”.   

 This date should only be entered if the student has un-enrolled from the 
class.   

 The End Date cannot be after the count date of the current roster. 

 The End Date cannot be a future date. 

Q – Middle Name Enter the student’s full middle name exactly as it appears on their birth certificate.  
Hyphens, apostrophes, and periods may be included.  If the student does not have a 

Middle Name, enter NMN to represent No Middle Name. This indicates you have 
verified there is not a middle name listed on the student’s birth certificate. 

R – Name Suffix  If applicable, select the appropriate Jr, II, III, IV, etc. value from the drop-down list. 

S – Waiver Reason 
Code 

If the Student’s SSN was not provided, enter the Waiver Reason Code (e.g., 1, 2, 3 
…) that corresponds with the reason selected by the Parent on the Social Security 

Number Information Form. 

Select Description 

1 I need help in obtaining an SSN. 

2 I need help replacing a lost SSN. 

3 I am awaiting a replacement SSN and will provide when it arrives. 

4 I forgot to bring the SSN and will provide within 30 days. 

5 I choose not to provide the SSN because …. 

o 

T – Waiver Reason 
Detail 

If the Waiver Reason Code = 5, enter the Waiver Reason Detail which is the 
handwritten reason given by the Parent on the Social Security Number Information 

Form. 
 

Note:  Do not enter any commas into this field. 

U – American Indian 

or Alaskan 
Native 

Select the appropriate Yes/No indicator from the drop-down list to indicate whether 

the race of American Indian/Alaskan Native is applicable to this student. 

V – Asian  Select the appropriate Yes/No indicator from the drop-down list to indicate whether 
the race of Asian is applicable to this student. 

W – Black or African 
American 

Select the appropriate Yes/No indicator from the drop-down list to indicate whether 
the race of Black or African American is applicable to this student. 

X – Native Hawaiian 
or Other Pacific 
Islander 

Select the appropriate Yes/No indicator from the drop-down list to indicate whether 
the race of Native Hawaiian or Other Pacific Islander is applicable to this student. 

Y – White  Select the appropriate Yes/No indicator from the drop-down list to indicate whether 
the race of White is applicable to this student. 
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For each student entered, select Y for at least one of the race values located in columns U-Y. Should 
it be necessary, you may indicate Y for as many races as are applicable for the student. 

 

Column – Field Action Required 

Z – GTID  Leave Column Z blank. Do not manually enter the student’s 10 digit GTID. This 

field is only included in the template so that the file format will match the pre-
populated files generated by Infinite Campus, Pearson PowerSchool, or ASPEN.     

AA – Parent/ 
Guardian First Name 

Enter the first name of the student’s Parent or Guardian (mother preferred if 
available). 

AB – Parent/ 
Guardian Last Name 

Enter the last name of the student’s Parent or Guardian (mother preferred if 
available). 

AC – Relationship From the drop-down list, select the appropriate relationship of the parent or guardian 
to the student:  

 Mother  Father   Grandparent  Guardian 
o 

 
 
 

Entering the parents or guardian’s information in columns AA - AC is optional; however, completion 
of all three becomes mandatory if data is populated in one of the fields. For example, if the 
Parent/Guardians first name is entered, then their last name and the relationship to the student must 
also be provided. 

 
 
5. Repeat step 3 for each student until all students for the respective Site have been entered.   

Note:  You can edit your .xls file as many times as needed.  
 
6. Once your entry of the student data is complete/accurate, follow the instructions included at the top of 

the DECAL template to delete the red and yellow highlighted rows so that your first student becomes 
the first row in the file.   

Important 

Important 
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7. Follow the steps below to save your file in both the XLS and CSV (Comma delimited) format. 

Step Action Required 

(a)  Click File> Save As> Save as Type> Excel 97-2003 Workbook (*.xls) or Excel Workbook (*.xlsx). 

(b)  In the File name field, enter the roster file name using the suggested naming convention 
<schoolname>_StudentRoster_<mmddyyyy>.xls.  Example:  Idlewood_StudentRoster_08142015.xls 
as the file name. 

(c)  Click Save. 

(d)  Click File> Save As> Save as Type> CSV (Comma Delimited) (*.csv). 

(e)  In the File name field, enter the roster file name using the suggested naming convention 

<schoolname>_StudentRoster_<mmddyyyy>.csv.  Example:  Idlewood_StudentRoster_08142015.csv 
as the file name. 

(f)  Click Save. 

(g)  If you receive a message indicating the file may contain features that are not compatible with the CSV 

format, click Yes. 

 
 
 

Each time you modify the .xls file, you need to repeat Step 6 and resave the file to BOTH the .xls and 
the .csv formats to keep them in sync. Use the .xls version for editing and the .csv version for uploading. 
If you edit the .csv file, it will drop the column attributes defined in the .xls template (e.g., the leading 
zeroes will be dropped from the SSN). This will result in formatting errors the next time you try to 
upload the .csv file.  

 
 
If you used the DECAL template, you can now skip to section – Uploading Your Completed Student 
Roster Files (page 30) – for instructions on how to upload your .csv file.  

Important 
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Creating an Upload File Using the Pre-Populated LSS File from Infinite Campus  

1. In Infinite Campus, navigate to System Administration > Resources > School.  Select the appropriate 
School and enter the Site ID. 

 

To verify your Site ID, go to 
Panda and do the following: 

(a) Click on Pre-K, 
Rosters, and then 
View/Edit Roster. 

(b) On the Provider Site 
List displayed, scroll 
to your County/Site 
Name to locate your 
Site ID. 

 

2. Enter the Panda Class ID on the Section of the Course you will be reporting. Navigate to Search > 
Course/Section > Enter course name or number > Select the section. Bright from the Start Panda 
Class # is on the Section tab. 

 

To determine your Class ID, do 
the following on the View/Edit 
Roster page: 

 Click on your Site 
Name. 

 The Class List page 
displays the Class IDs 
for each class at that 
Site.   

 

 
Note:  You will need to verify your Class ID values each year, as the Class ID values change each 
school year. 

 

3. Populate the specific Pre-K fields listed below into Infinite Campus for each student by navigating to 
Student Info > General > BFTS Data:     
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Enter the data into Infinite Campus directly instead of attempting to populate the downloaded extract.    

 
 

Column – Field  Action Required 

Birth Indicator If the child is from a single birth, twin, or higher-order multiple birth, enter the total 
number of children from the pregnancy as the Multiple Birth value.  

Select Description 

1 If the child was born from a single birth 

2 If the child was born from a twin birth 

3 If the child was born from a triplet birth 

4 If the child was born from a quadruplet birth 

o 

Socio/Economic Select the appropriate Socio-Economic indicator from the drop-down.  

 Category 1      Select this option if the child and/or child’s family participates in one of the 
following: Supplemental Nutrition Assistance program (SNAP), SSI (Supplemental Security 
Income), Medicaid, Temporary Assistance to Needy Families (TANF), or Child and Parent 
Services (CAPS) program. Documentation of participation must be verified and kept on file. 
Children who participate in the free and reduced meal program through the school that they 
attend may also be eligible as Category One if income eligibility is verified and kept on file. 
 

 Category 2      Select this option if the child does not meet the requirements for Category 1 
eligibility. 

Transportation If the center transports the student to and from Pre-K, select Yes from the Transportation 

drop-down list. If the student is not transported by the Center, select No.   

Funding  Verify that the Class Funding Source displayed is correct and edit this field if needed.    

Select Description 

Blended If the class receives both Head Start and Pre-K funding 

Lottery If the class only receives Pre-K funding 

o 

Waiver Reason 
Code 

If the Student’s SSN was not provided, enter the Waiver Reason Code (e.g., 1, 2, 3 …) 
that corresponds with the reason selected by the Parent on the Social Security Number 

Information Form. 

Select Description 

1 I need help in obtaining an SSN. 

2 I need help replacing a lost SSN. 

3 I am awaiting a replacement SSN and will provide when it arrives. 

4 I forgot to bring the SSN and will provide within 30 days. 

5 I choose not to provide the SSN because …. 

o 

Waiver Reason 
Detail 

If the Waiver Reason Code = 5, enter the Waiver Reason Detail which is the handwritten 
reason given by the Parent on the Social Security Number Information Form. 

 
4. Repeat step 3 for each Pre-K student in attendance. 
 

Important 
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5. Once you have completed populating the Pre-K fields for each student, proceed to download the 
Bright from the Start extract for each of your Pre-K sites.  

 Navigate to GA State Reporting > Bright from the Start Extract.  

 Select the desired school(s) and click Download. 
 
6. Save each csv file to a folder on your computer using the following suggested naming convention   

<schoolname>_StudentRoster_<mmddyyyy>.csv.  Example: Idlewood_StudentRoster_08142015.csv 
 

DO NOT open the file in Excel prior to saving it to your computer. 
 
7. If desired, you may double-click on the .csv file you just saved, launching Microsoft Excel, so that you 

can easily verify that all columns are populated and that the correct students are shown and are 
associated with the correct PANDA Site ID and Class ID.  

 ONLY VIEW THE FILE IN EXCEL.  

 DO NOT SAVE THE FILE IN EXCEL as this will cause all leading zeroes to be dropped 

from the student’s SSNs triggering records to error out in the upload process. 

 

 

If the Pre-K specific data fields outlined above were NOT entered into Infinite Campus, you will need to 
go back and complete steps 1-4.  It is preferred that the Pre-K data be entered into Infinite Campus rather 
than manually entering it into the extracted files. 

 

 

 

 

 

 

 
 
8. Once your data is accurate and complete, you are ready to upload the file(s) to PANDA.  Proceed to 

the section – Uploading Your Completed Student Roster Files (page 30). 
 

Note:  Because the prepopulated files from LSS are already in CSV format, there is no longer a need 
to maintain both the XLS and CSV file versions as required when using the DECAL template due to 
the prepopulated LSS file containing built-in data validations.  

 

DO NOT edit the saved .csv files. 

If any mistakes are found in the .csv files, do the following: 

 Go back to Infinite Campus and correct the data entry(s) (steps 3 and 4) 

 Generate a new extract file (steps 5 and 6) 

X 

Important 
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Creating an Upload File Using the Pre-Populated LSS File from PowerSchool 

1. Provide the PowerSchool Administrator for your district with the PANDA Site IDs for your District.  
They will need to setup the sites on the District page in PowerSchool before the Early Care and 
Learning Pre-K Extract Report (i.e., your pre-populated roster files) can be generated.   

a) To verify your Site ID, go to Panda and click on Pre-K, Rosters, and then View/Edit Roster. 

 

b)  On the Provider Site List displayed, scroll to your County/Site Name to locate your Site ID. 
 

2. Ask the PowerSchool Administrator to ensure that your PowerSchool login has ‘edit’ access, enabling 
you to enter the Pre-K specific fields detailed below for each of your Pre-K students. This data should 
be entered into PowerSchool BEFORE the pre-populated files are generated.   

 
 

 

If someone besides you will be the one entering the Pre-K student data into PowerSchool, such as a 
School Level Data Clerk, please be sure to provide them with the Roster Information Form for each 
student.   

 
 

Also, be aware that sometimes a parent will provide the Student’s SSN on the Roster Information 
Form even though they may not have previously provided it on any other school forms.  If the SSN 
is present on the Pre-K form, please verify that it has been entered into PowerSchool. 

 
3. Populate the specific Pre-K fields listed below into PowerSchool for each student:     

 

Important 
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Field Action Required 

Panda Class ID  Enter the PANDA Class ID.   

(a) Go to Panda and click on Pre-K, Rosters, and then View/Edit Roster. 

(b) To determine your Class ID, click on your Site Name.  

(c) The Class List Page displays the Class IDs for each class at that Site.   

 

Note:  You will need to verify your Class ID values each year, as the Class ID values 
change each school year.0 

Pre-K Program 
Code  

Select the appropriate Pre-K Program Code from the dropdown. This represents what is 
known as the Class Funding Source in PANDA.    

Select Description 

Blended If the class receives both Head Start and Pre-K funding 

Lottery If the class only receives Pre-K funding 

O 

Multiple Birth 

Value  
If the child is from a single birth, twin, or higher-order multiple birth, select the number of 

children from the Multiple Birth drop-down list.  

Select Description 

1 If the child was born from a single birth 

2 If the child was born from a twin birth 

3 If the child was born from a triplet birth 

4 If the child was born from a quadruplet birth 

o 

Dual Language 
Learner 

Check the Dual Language Learner checkbox if English is not the student’s primary language; 
otherwise, leave the checkbox ‘blank’. 

Socio Economic 
Indicator 

Select the appropriate Socio-Economic indicator from the drop-down.  

 Category 1      Select this option if the child and/or child’s family participates in one of the 
following: Supplemental Nutrition Assistance program (SNAP), SSI (Supplemental Security 
Income), Medicaid, Temporary Assistance to Needy Families (TANF), or Child and Parent 
Services (CAPS) program. Documentation of participation must be verified and kept on file. 
Children who participate in the free and reduced meal program through the school that they attend 
may also be eligible as Category One if income eligibility is verified and kept on file. 
 

 Category 2      Select this option if the child does not meet the requirements for Category 1 

eligibility. 

Transportation 
will be provided 

Check the Transportation checkbox if the Center transports the student to and from Pre-K; 
otherwise, leave the checkbox ‘blank’.   
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Field Action Required 

Waiver Reason 
Code 

If the Student’s SSN was not provided and entered into PowerSchool, select the Waiver 
Reason Code (e.g., 1, 2, 3 …) that corresponds with the reason selected by the Parent on the 

Social Security Number Information Form: 

Select Description 

1 I need help in obtaining an SSN. 

2 I need help replacing a lost SSN. 

3 I am awaiting a replacement SSN and will provide when it arrives. 

4 I forgot to bring the SSN and will provide within 30 days. 

5 I choose not to provide the SSN because …. 

O 

Waiver Reason 

Detail 

If the Waiver Reason Code = 5, enter the Waiver Reason Detail which is the handwritten 

reason given by the Parent on the Social Security Number Information Form. 

 
4. Repeat step 3 for each Pre-K student in attendance.  
 

5. From the report’s menu available in PowerSchool, request the Early Care and Learning PK Extract 
Report for each of your Pre-K sites.   

a) Please reach out to your PowerSchool Administrator if you need assistance.  

b) Save each csv file to a folder on your computer using the following suggested naming 
convention <schoolname>_StudentRoster_<mmddyyyy>.csv.  Example:  
Idlewood_StudentRoster_08142015.csv as the file name. 

 
DO NOT open the file in Excel prior to saving it to your computer. 

 

6. If desired, you may double-click on the .csv file you just saved, launching Microsoft Excel, so that you 
can easily verify that all columns are populated and that the correct students are shown and are 
associated with the correct PANDA Site ID and Class ID.  

a) ONLY VIEW THE FILE IN EXCEL.  

b) DO NOT SAVE THE FILE IN EXCEL as this will cause all leading zeroes to be dropped 
from the student’s SSNs triggering records to error out in the upload process. 

 
 

 

If the Pre-K specific data fields outlined above were NOT entered into PowerSchool, you will need to 
go back and complete steps 2-4.  It is preferred that the Pre-K data be entered into PowerSchool rather 
than manually entering the data into the extracted files. 

 

 

 

 

 

 

DO NOT edit the saved .csv files. 

If any mistakes are found in the .csv files, do the following: 

 Go back to PowerSchool and correct the data entry(s) (steps 3 and 4) 

 Generate a new extract file (steps 5 and 6) 

X 

Important 
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7. Once your files are accurate and complete, you are ready to upload them to PANDA. Proceed to the 
next section – Upload Your Completed Student Roster Files (page 30). 

 
Note:  Because the prepopulated files from LSS are already in CSV format, there is no longer a need 
to maintain both the XLS and CSV file versions as required when using the DECAL template due to 
the prepopulated LSS file containing built-in data validations.  
 



 Student Data Training Document 

Bright from the Start : Georgia Department of Early Care and Learning Page 26 of 44 

Creating an Upload File Using the Pre-Populated LSS File from ASPEN 

1. Work with your ASPEN district coordinator to ensure the State Codes have been updated in the Person 
Relationship Codes Table. The only acceptable values that can be reported in the PANDA Export are:  
Mother, Father, Grandparent, and Guardian. Assign these state codes to the appropriate values in the 
State Code column in the below reference table.   

 
  

2. Have your ASPEN district coordinator ensure that the School table has the correct PANDA Site Id 
values and that the Schedule Master table has the correct PANDA Class ID values for our location. 
The Site IDs remain the same each year, but please note that a new Class ID is assigned each year 
when a class is funded.    
 
The Site ID and Class ID values can be found in PANDA on the View/Edit Roster screens as shown 
below: 

Value Action Required in PANDA 

Site ID (a) Click on Pre-K, 

Rosters, and then 
View/Edit 

Roster. 

(b) On the Provider 
Site List page 
displayed, scroll 
to your 
County/Site 
Name to locate 
the Site ID. 
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Value Action Required in PANDA 

Class ID (a) On the View/Edit 
Roster page, click 
on your Site Name. 

(b) The Class List page 
displays the Class 
IDs for each class at 
that Site. 

 

 

 
3. Populate the specific Pre-K fields listed below into ASPEN for each student.   

  

All of the data fields have been created with List Edit ability, so users can easily update the student 
data using list view if desired. 

Column – Field  Action Required 

Birth Indicator If the child is from a single birth, twin, or higher-order multiple birth, enter the total 

number of children from the pregnancy as the Multiple Birth value.  

Select Description 

1 If the child was born from a single birth 

2 If the child was born from a twin birth 

3 If the child was born from a triplet birth 

4 If the child was born from a quadruplet birth 

o 

Socio/Economic Select the appropriate Socio-Economic indicator from the drop-down.  

 Category 1      Select this option if the child and/or child’s family participates in one of the 
following: Supplemental Nutrition Assistance program (SNAP), SSI (Supplemental Security 
Income), Medicaid, Temporary Assistance to Needy Families (TANF), or Child and Parent 
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Column – Field  Action Required 
Services (CAPS) program. Documentation of participation must be verified and kept on file. 
Children who participate in the free and reduced meal program through the school that they 
attend may also be eligible as Category One if income eligibility is verified and kept on file. 
 

 Category 2      Select this option if the child does not meet the requirements for Category 1 
eligibility. 

Transportation If the center transports the student to and from Pre-K, select Yes from the Transportation 

drop-down list. If the student is not transported by the Center, select No.   

Funding  Verify that the Class Funding Source displayed is correct and edit this field if needed.    

Select Description 

Blended If the class receives both Head Start and Pre-K funding 

Lottery If the class only receives Pre-K funding 

o 

Waiver Reason 
Code 

If the Student’s SSN was not provided, enter the Waiver Reason Code (e.g., 1, 2, 3 …) 
that corresponds with the reason selected by the Parent on the Social Security Number 

Information Form. 

Select Description 

1 I need help in obtaining an SSN. 

2 I need help replacing a lost SSN. 

3 I am awaiting a replacement SSN and will provide when it arrives. 

4 I forgot to bring the SSN and will provide within 30 days. 

5 I choose not to provide the SSN because …. 

o 

Waiver Reason 
Detail 

If the Waiver Reason Code = 5, enter the Waiver Reason Detail which is the handwritten 
reason given by the Parent on the Social Security Number Information Form. 

 
4. Repeat step 3 for each Pre-K student in attendance. 
 
5. Once you have completed populating the Pre-K fields for each student, proceed to download the GA 

PANDA Roster Export. We recommend pulling a separate export for each Site within your district.   
 
6. Save each csv file to a folder on your computer using the following suggested naming convention   

<schoolname>_StudentRoster_<mmddyyyy>.csv.  Example: Idlewood_StudentRoster_08142015.csv   
 

DO NOT open the file in Excel prior to saving it to your computer. 
 

7. If desired, you may double-click on the .csv file you just saved, launching Microsoft Excel, so that you 
can easily verify that all columns are populated and that the correct students are shown and are 
associated with the correct PANDA Site ID and Class ID.  

 ONLY VIEW THE FILE IN EXCEL.  

 DO NOT SAVE THE FILE IN EXCEL as this will cause all leading zeroes to be dropped 
from the student’s SSNs triggering records to error out in the upload process. 
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If the Pre-K specific data fields outlined above were NOT entered into ASPEN, you will need to go back 
and complete steps 3 and 4.  It is preferred that the Pre-K data be entered into ASPEN directly rather 
than manually entering the data into the extracted files. 

 

 

 

 

 

 

 
 
8. Once your data is accurate and complete, you are ready to upload the file(s) to PANDA.  Proceed to 

the section – Uploading Your Completed Student Roster Files (page 30). 
 

Note:  Because the prepopulated files from ASPEN are already in CSV format, there is no longer a 
need to maintain both the XLS and CSV file versions as required when using the DECAL template due 
to the prepopulated LSS file containing built-in data validations.  

 

  

DO NOT edit the saved .csv files. 

If any mistakes are found in the .csv files, do the following: 

 Go back to ASPEN and correct the data entry(s) (steps 3 and 4) 

 Generate a new extract file (steps 5 and 6) 

X 

Important 
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Uploading Your Completed Student Roster Files  

When your upload file(s) are ready, complete the following steps to upload your student roster data. 

1. On PANDA’s main menu, click Pre-K, Rosters, and then the View Roster Upload Status. The View 
Upload Status window displays.  
 

2. Click .  
 

3. On the Upload File window, click on Choose File or enter the full path to the desired roster .csv file. 

 
 

4. Click .   

 If the specified file was successfully retrieved, PANDA displays a message on the screen that 

the uploaded file was accepted for processing.  

 If the file was not found or was not a .csv file, an error message will display. 

 

5. Click  to return to the View Upload Status screen where you can monitor the progress of the 

upload by clicking . You will receive e-mails from PANDA confirming when the file 
was received, if an error occurred, or if records were loaded to the roster. 
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View Roster Upload Status and Resolve Data Errors 

 
 

After you upload your roster files to DECAL, you must check the upload status and resolve any data 
errors. Failure to resolve the student exceptions will prevent all students from loading to the roster. 
DO NOT ignore errors or attempt to manually add the missing students. 

 

To check the status of your upload and resolve potential errors, complete the following steps: 

1. On the View Roster Upload Status page, click the  button to view the student file upload 
status.  

 
 

The status for all files loaded thus far during Roster 1 of the current school year will display.   
 
2. Continue to click on the Search/Refresh button to refresh the information displayed until the file 

being loaded has completed the validation/upload process.    
 
3. The following table describes the possible status values that may be received during the upload process: 

Upload Status Description 

File Received For 
Validation 

This indicates the file was successfully located and the validation process has started.   

Total No. of Fields in 
one or all rows in 
incorrect 

This indicates there is a problem with the file layout itself on one or more rows in the 
file.  Typical reasons a file layout error occurs include: 

 An empty file was uploaded. 

 Records in the file have too many columns or not enough columns. Each 
row should only contain 26 columns.   

Invalid Site/Class 
Combination 

This indicates that one or more records in the file contains an invalid Site ID or Class 
ID.   

Note:  The upload process will stop if even just one invalid record is found. You will 
need to correct your file and upload again. 

Validation In 
Progress 

The roster file that you uploaded has passed the file layout validations and the record 
is being validated against the data edits for each individual field on the record. 

Upload Exception PANDA found invalid values on one or more student records.   

Important 
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Upload Status Description 

Note:  All valid records will load to the roster but you will need to correct the 
records that have exceptions in order for them to load. The correction process is 

described starting on step 4. 

Validated The roster validation of each individual field for each student is complete and no 
errors were found. 

Save In Progress After the roster has been successfully validated and the records have loaded to the 

database, its status changes to Save In Progress. The roster is ready to be reviewed 
and marked as ‘Roster Updates Complete’. 

 
4. If you received the Upload Exception error, click on the yellow Select box  next to the File ID to 

display the Error Report screen. Each student that was flagged with an error will be listed. 
 
5. Select a student record by clicking the yellow Select box  next to the student’s name.  

 
 

6. The Student Error Correction screen displays showing the specific field (s) that contain invalid 
information. 
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Note:  If you have a small number of students with errors, it will be easier to correct them on the 
Student Error Correction screen. However, if most of your records have errors, you may find it easier 
to update your file and perform the upload steps again. 

 
7. Review the student’s record and enter your corrections in the Correct Information column.  

 

8. Click the  button to save your changes for the student. 
 

9. Click  to return to the Student Error report. The corrected student record is no longer listed on 
the report and the Number of Error Records is reduced by one. 

 
10. Repeat steps 5-8 for each student listed on the Error Report screen. When you are finished, return to 

the View Upload Status screen.  
 

11. Click the  button. The upload file status should now show Save In Progress, and you 
are ready to review your roster to confirm all data shown is correct and to click on Roster Updates 
Complete. Once all classes are complete and the Count Date has arrived, you are ready to submit your 
roster for each Site by following the instructions on the next page.      

 
 
 

Once you have successfully uploaded your students, DO NOT attempt to upload the file again for the 
same class or it will wipe out the students already loaded. If you notice a correction is needed to the 
student data, this should be done via the online screens or by contacting the PANDA Rosters at 
Panda.Rosters@decal.ga.gov. 

 
 
 

  

Important 
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Submitting Your Completed Roster to DECAL 

 

If you failed to include a student on a roster previously submitted to DECAL, you can add the 
student onto the next roster; however, you cannot back date the entry to correct the mistake.  The 
Begin Date you enter has to be greater than the Count Date of the prior roster.  It is highly recommended 
that you carefully review each roster for accuracy before submitting.  

 

1. When you have entered/verified all of the teacher and student data on your roster(s), click the    

 button located at the bottom of the Roster Details page.   

Note:  If there are any errors, a message will appear at the top of the screen. The roster status will not 
change to Roster Updates Complete until the error(s) has been resolved. Note that in some browsers, 
you may not be able to scroll up to see the popup message. If that occurs, change your zoom level and 
ensure you have enabled popups. 

 

2. Click the  button. The Roster Class List screen displays. Notice the roster status field shows 
Roster Updates Complete. 

 
 

3. Click the  button to review the roster status for each site. After all classes are marked 
complete, the site status will display Roster Updates Complete. The site can then be submitted 
beginning on the count date for each roster cycle. 

 
4. To submit the site: (a) read the statement below the site(s) information, (b) click the white checkbox to 

the left of the Site ID, and then (c) click Continue.  
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5. The following Roster Submission popup screen will be displayed. Read the message very carefully 

before proceeding.  

 
 

6. Choose one of the following options: 

Select Condition 

Accept If you concur that all of the data entered is true and accurate to the best of your knowledge, 
and that you understand any false, fraudulent, or fictitious representation is punishable by 

law and could result in a felony charge.  

Return to 
Roster 

If you are unsure and need to go back and carefully review the data entered – wait to 
submit until you have verified the data is correct. 

 
7. After selecting Accept, complete the submission process by clicking the Submit button. The site's 

Roster Status will change to Submitted.  
 

You will receive a confirmation e-mail from DECAL to inform you that your roster has been 
successfully submitted to DECAL. The e-mail will also give you a count of the number of classes that 
were submitted. If all classes were not submitted, you will need to go back to the roster to see which 
classes did not submit successfully. 

 
 
 

By submitting the roster(s), you are asserting via electronic signature that the information on the 
roster(s) is true, complete, accurate, and includes all available student and teacher information. Social 
Security numbers must be entered unless a parent signed waiver is on file. 

 
 

Important 
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Printing a PANDA Roster Report 

After you finish entering your rosters, you can generate the PANDA Roster Report. This report lists the 
lead teacher, assistant teacher, and students enrolled in each class on the count day.      

1. In PANDA, select View/Edit Roster and pull up the desired Site or Class.   
 
2. Whether pulling the report at the Provider level, Site level, or individual Class level, each roster screen 

will display two Print options:  

Level  Action Required 

Provider Navigate to the View/Edit Roster window and click on either Provider Roster Report or 
Provider Roster Reports w/o SSN in the upper right corner. 

 

Site Navigate to the View/Edit Roster window and click on the Site Name.  The Roster Class 
List window displays. In the upper right corner, click Reports and select either Site 
Roster Report or Site Roster Reports w/o SSN. 

   

Class Navigate to the Roster Class List and click the Class ID. In the upper right corner on the 
Roster Class List window, click Print or Print Without SSN. 

 

 
3. Use the following criteria to determine which print option to select: 

Select Condition 

 Provider Roster Report  

 Site Roster Report  

 Print  

The report generated by selecting either the Provider Roster 
Report, Site Roster Report, or Print button should ONLY 
be viewed by the Project Director to confirm data accuracy 
(if you prefer not to view it online for accuracy), as this 
report contains SSN’s.  
 
Please take appropriate action to shred the report once 
you have finished verifying/correcting the roster data. 

 Provider Roster Reports w/o SSN 

 Site Roster Reports w/o SSN 

 Print Without SSN 

The report generated does not contain the SSN’s. This report 
should be printed and given to the Lead Teacher for each 
Pre-K class in your program. They will need the PANDA 
Student ID from this report in order to accurately enter their 
students into the Work Sampling Online (WSO) System. 
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4. The PANDA Roster Report will display in a separate browser window. You can then select the Print 

icon ( ), export to another file type (i.e., PDF, Excel, Word, etc.,), or you can save the Without SSN 
version to a file to e-mail to the teacher if she works at a different location from the Project Director. 
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How to Update Your Student Information 

1. On the Provider Site List window, click name of the site that you want to update or change. The Class 
List page displays. 

 

2. Click the Class ID hyperlink next to the class that you want to update. The Class Roster page displays.   
 

3. Follow the steps below to make your changes:  

Fields Impacts 
Funding 

Action Required 

Gender, 
Multiple Birth, 
and IEP  

No The fields are displayed as hyperlinks.   

(a) Locate the student’s name on the roster and click the field that needs to be changed. 

 

(b) The field menu opens.   

(c) Select the correct value and then click  to save the changes. 

Transportation 

and 
Socio/Economic 

 

 

Yes Updates to these fields require the addition of an effective or start date as changes 

will impact the amount of your Pre-K funding:  

(a) Click on the student’s last name. 

(b) Click on Chg Trans/Socio in the upper right corner of the Student Information 
window. Transportation and Socio/Economic are the only editable fields. 

(c) After you make the necessary change(s), the system will prompt you for an 
Effective date of Change. To determine the effective date: 

If Then 

Changing 
Transportation 
from NO to 
YES 

Enter the date you began providing transportation for the 
student. If you ALWAYS provided transportation for this 
student, then effective date should be the next day after the 
BEGIN date in class. 

Changing 
Transportation 
from YES to 
NO 

Enter the date you stopped providing transportation for the 
student. If you never provided transportation for the student, 
then the effective date should be the next day after the BEGIN 
date in class. 

Changing from 
Category 1 to 
Category 2 

Enter the date the student became INELIGIBLE for Category 1 
status. If the student was NEVER eligible, then the effective 
date should be the next day after the begin date in class. 

Changing from 
Category 2 to 
Category 1 

Enter the date the student became ELIGIBLE for Category 1 
status. If the student was ALWLAYS eligible, then the effective 
date should be the next day after the begin date in class. 

(d) Enter the effective date and click Save to update the record. 

 
Example Roster View Before Transportation Change: 
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Fields Impacts 
Funding 

Action Required 

Example Roster View After Transportation Change: 

 

SSN, Name, 
and/or Date of 
Birth 

No To correct SSN’s, names, and/or birth dates, send documents (e.g., birth certificate 

or court decree for name changes) to support your request to the DECAL Finance 
Office via their secured fax line at 404-651-8576.  DO NOT close and re-add the 
student. This will flag them as a duplicate which will result in you being contacted by 

DECAL to provide all of their documentation. 

 
4. Click Save to update the record. 

 
5. If the student has withdrawn, complete the following steps to close the students record: 

(a). On the current open roster, click on the student’s Last Name to open the selected student’s 
information window.  

(b). Click the Close Student button at the top of the screen. The Close Student pop up window 
displays. 

  

(c). Click on the calendar icon ( )to select the last date of attendance. 

(d). Click Save to update the record. 
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How to Search for a Student within Your Program 

1. In the left-side navigation menu, select (a) Pre-K, click on (b) Rosters, and then select (c) Search 
Child. 

 
 

 

2. In the Search Child window, use the Year dropdown menu to select the desired calendar year. 
 
3. In one or more of the search criteria fields, enter the student’s Last Name, First Name, Middle Name, 

Student ID, etc. and click Search.  

  
 

Search Tips:   

 If you are unsure of the spelling of a student’s name, you can enter a partial first or last name 
to give you a list of possible students. 

 The field values are not case-sensitive, therefore upper- or lower-case letters will yield the 
same results. 

 Start with a broad search using only one field and then narrow your search down using two or 
more fields. 
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4. All records that meet the search criteria are displayed. If you do not obtain the results you were 
expecting, check for spelling or typing errors.  
 

5. The Child Name column displays each student’s name as a hyperlink. Click on the student’s name to 
view the record details. 
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Frequently Asked Questions Relating to Rosters 

Q. What is the difference in the count date and the due date? 

A. All roster changes or corrections that have occurred up to and through the count date can be made on 
the current open roster. The count date represents the date at which the information on the roster is 
accurate and correct. 

 
DECAL allows extra time to record the roster data (accurate as of the count date) on the roster before 
it must be submitted to our office. The due date is therefore the last date that the roster can be 
submitted without being considered late.  

 
Each roster should show the changes in your class room as of the count date. It is important to 
remember, you cannot submit your roster prior to the count date. You may begin submitting on or 
after the count date and can continually report changes that occur in your class until the end of the 
count date. Rosters are required to be submitted by the due date which is generally one week following 
the count date. 
 
Any changes that occur after the count date will go on the next roster. No students can be added to the 
roster after the final count date.   
 
You may find your count dates on the list of Critical Reporting Dates in the Georgia Pre-K Operating 
Guidelines.   

 
 
Q. One of my students has withdrawn.  How do I remove the student from the roster? 

A. On the current open roster, click on the student’s last name to open the selected student’s information 
window. Click the Close Student button at the top of the screen. Enter the last date of attendance and 
click Save to update the record. 

 
 
 
Q. How do I make corrections to the Gender, Multiple Birth, and, IEP roster fields? 

A. You can correct Gender, Multiple Birth, and IEP simply by finding the student’s name on the roster, 
click the field (blue link) that needs to be changed, make the needed change, and then save the entry. 
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Q. How do I make corrections to the Category or Transportation roster fields? 

A. If you need to edit the Category or Transportation fields, complete the following steps based on the 
roster submission status. 

 

Prior to Submission of Roster 1:  

Step Action Required 

(1)  Click on the yellow Select box next to the student’s name. 

(2)  Enter the corrected values. 

(3)  Click Save to update the record. 

 

After Roster 1 has been Submitted: 

Step Action Required 

(1)  Click on the yellow Select box next to the student’s name. 

(2)  Click on the Chg Trans/Socio button at the top of the Student Information window.  Transportation 

and Socio/Economic are the only editable fields. 

(3)  After you select an option from the drop-down list, the system will prompt you for an Effective date 

of Change. To determine the date: 

If Then 

Changing 
Transportation 
from NO to 
YES 

Enter the date you began providing transportation for the student. If you 
ALWAYS provided transportation for this student then effective date should be 
the next day after the BEGIN date in class. 

Changing 
Transportation 
from YES to 
NO 

Enter the date you stopped providing transportation for the student. If you never 
provided transportation for the student, then the effective date should be the 
next day after the BEGIN date in class. 

Changing from 
Category 1 to 
Category 2 

Enter the date the student became INELIGIBLE for Category 1 status. If the 
student was NEVER eligible, then the effective date should be the next day 
after the begin date in class. 

Changing from 
Category 2 to 
Category 1 

Enter the date the student became ELIGIBLE for Category 1 status. If the 
student was ALWLAYS eligible, then the effective date should be the next day 
after the begin date in class. 

o 

(4)  Enter the effective date. 

(5)  Click Save to update the record. 

 
 

Q. How do I make corrections to the SSN, Name, or Date of Birth roster fields? 

A. If you need to correct a student’s SSN, Name, or Date of Birth, submit the Pre-K Roster Correction 
Request Form and supporting documentation to Panda Rosters via the secured fax line at 404-651-
8576. The Pre-K Roster Correction Form is located at http://decal.ga.gov/PreK/ProjectDirectors.aspx. 
DO NOT close and re-enter the student as this will flag the student as a duplicate and will require 
submission of student documentation to DECAL.  

 
 
 

http://decal.ga.gov/PreK/ProjectDirectors.aspx
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Q. A parent has decided to provide the social security number (SSN) for a student already on the 
roster. How do I add the SSN? 

A. SSNs can be added during open roster periods. Any child without a SSN listed will have the words 
POPULATE SSN in the SSN field on the roster. After you locate the student on the roster, click on 
the POPULATE SSN link, enter the student’s SSN, double check your entry for accuracy, and then 
click Save. 

 
 
Q. I have completed my updates and I am on the site list screen, but I don’t see a submit button.  

Where is the submit button? 

A. Only one person will see the submit button and that is the person with the Provider Management role. 

 
 You are trying to submit a roster before the Count Date. 

 You are trying to submit a roster that does not have a ROSTER UDPATES COMPLETE status.  
 

To obtain the correct roster status, complete the following steps: 

Step Action Required 

(1)  On the Provider Site List window, click the hyperlinked Site Name you want to correct. The Class 
List window displays. 

(2)  Click the hyperlinked Class ID you want to update. The Class Roster page displays.   

Note:  Each class must be updated to Roster Updates Complete separately. 

(3)  
The  button located in the upper right corner on the Roster Details page. Once 
you locate the button, click it to update the status to Roster Updates Complete. 

(a) If there are errors, a message will appear in red at the top of the page. You will have to fix the 

errors and then click the Roster Updates Complete button again.  

(b) If there are no errors, click the Return to Class List button at the top of the page. Once you 
are on the class list, you will click the Return to Site List button at the top of the page. 

(4)  Once you are on the Site List page and you have a status of Roster Updates Complete, begin the 

submit process by reading the certifications and following the instructions provided on each screen. 
You will not see the submit button until you have accepted the certifications. 

 
 
 

By submitting this roster(s), you are asserting via electronic signature that the information on the 
roster(s) is true, complete, accurate, and includes all available student and teacher information. Social 
Security numbers must be entered unless a parent signed waiver is on file. 

 
 

If you are the Provider Manager and don’t see the submit button, then… 

Important 
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